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I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set
"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>
Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,
etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions
(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste
an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only
downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	This	is	a	complete	guide	with	several	methods	you	can	employ	to	be	able	to	insert	or	type	the	Alpha	Symbol	or	Sign	(α)	anywhere	on	your	PC,
like	Microsoft	Word/Excel/PowerPoint,	whether	you	are	using	the	Windows	or	on	the	Mac	keyboard.	Without	any	wasting	much	time,	let’s	get	to	work.	To	type	the	Alpha	Symbol	anywhere	on	your	PC	or	Laptop	keyboard	(like	in	Microsoft	Word	or	Excel),	press	Ctrl	+	g,	Ctrl	+	a	shortcut	for	Mac.	And	if	you	are	using	Windows,	simply	press	down	the	Alt
key	and	type	224	using	the	numeric	keypad	on	the	right	side	of	your	keyboard.	However,	to	type	this	symbol	in	MS	Word,	just	type	03B1,	select	it	and	then	press	Alt	+	X	to	get	the	Alpha	sign.	The	table	below	contains	everything	you	need	to	know	to	be	able	to	type	this	symbol	on	both	Windows	and	Mac.	Name	of	SymbolAlpha	signSymbol	TextαSymbol
Alt	Code224Shortcut	for	WindowsAlt	+	224Shortcut	for	MacCtrl	+	g,	Ctrl	+	aShortcut	in	Word-103B1,	Alt+X	Whether	you	are	using	Windows	or	Mac,	the	above	information	is	enough	for	you	to	write	the	Alpha	sign	into	your	Word/Excel	document.	However,	if	you	are	not	satisfied	with	this	quick	help,	keep	reading	below	as	I	will	explain	in	detail,	how
to	get	the	Alpha	symbol	or	any	other	symbol	anywhere	on	your	Mac	or	Windows	PC	like	in	MS	Word/Excel/PowerPoint.	As	you	may	already	know,	there	are	several	dual-purpose	keys	on	the	keyboard	for	both	Windows	and	Mac.	That	is	to	say	that	there	are	symbols	readily	available	as	second	keys	on	the	keyboard.	Just	by	pressing	two	or	more	keys
simultaneously,	you	can	easily	insert	such	symbols	into	your	work.	For	instance,	pressing	Shift	+	7	keys	give	you	the	Ampersand	(&)	sign.	However,	other	symbols	aren’t	printed	on	the	keyboard	as	second	keys.	This	makes	it	difficult	to	type.	One	of	these	symbols	is	the	Alpha	symbol	(α).	Typing	becomes	very	difficult	for	you	if	you	need	to	add	some	of
these	symbols	regularly	into	your	work.	But	it	doesn’t	have	to	be	difficult.	Especially	now	that	you	are	reading	this	step-by-step	guide.	In	the	following	sections,	I	will	show	you	all	the	easy	ways	to	type	or	insert	this	symbol	(α)	anywhere	on	your	Windows	or	Mac	PC	(such	as	Word	or	Excel	or	PowerPoint).	In	a	couple	of	minutes,	I’ll	explain	several
methods	you	can	use	to	get	this	(α)	and	any	other	symbol	as	and	when	the	need	arises.	As	a	quick	guide,	press	down	the	Alt	key	and	type	224	alt	code	on	your	numeric	keypad.	You	can	also	press	Ctrl	+	g,	Ctrl	+	a	on	Mac.	However,	without	any	further	ado,	below	are	the	methods	explained	into	details.	The	Alpha	Symbol	Shortcut	for	Mac	is	Ctrl	+	g,
Ctrl	+	a.	Windows	has	several	shortcuts,	some	of	which	works	only	in	Microsoft	Word.	However,	there’s	a	Windows	shortcut	for	the	Alpha	Sign	that	works	across	all	applications.	It	is	the	alt	code	shortcut	which	is	Alt+224	(will	be	discussed	in	the	next	section).	The	Alpha	Symbol	shortcut	for	Microsoft	Word	is	03B1,	Alt	X.	This	works	in	Microsoft	Word
Only.	To	use	this	on	Windows	(for	Word),	obey	the	following	instructions:	Place	the	insertion	pointer	in	the	right	place.Type	03B1	on	your	keyboard,	then	press	Alt	+	X.	These	steps	will	convert	the	code	into	the	Alpha	symbol	at	where	you	place	the	insertion	pointer.	Below	is	a	breakdown	on	how	to	use	the	Alpha	symbol	shortcut	for	Mac:	First	of	all,
place	the	insertion	pointer	where	you	need	to	insert	the	symbol.Now,	using	the	Mac	keyboard,	Press	Ctrl	+	g,	Ctrl	+	a	simultaneously.	This	shortcut	should	insert	the	symbol	for	you	on	your	Mac	PC.	In	the	next	section,	I’ll	show	you	how	to	use	the	Alpha	Symbol	Alt	Code	to	type	the	symbol	on	your	keyboard.	Using	the	symbol	font	type,	you	can	turn
the	a	letter	into	the	Alpha	symbol	with	with	some	few	mouse-clicks.	To	do	so:	Place	the	insertion	pointer	where	the	symbol	will	be	inserted.Type	the	letter	A	or	a.Select	the	letter	you	just	typed.Under	the	Home	tab,	in	the	Font	group,	click	the	drop-down	arrow	on	the	font	selector.	Scroll	down	and	select	the	font	type	named	Symbol.	The	symbol	font
type	will	change	the	letter	a	into	the	Alpha	symbol.	The	Alpha	(α)	Symbol	Alt	Code	is	224	and	0177.	Every	symbol	in	Word	has	a	unique	code	that	you	can	use	to	insert	the	symbol	into	your	document.	This	code	is	well	known	as	“Alt	code”.	Below	are	the	steps	to	type	this	symbol	on	your	keyboard	(using	the	Alt	code	provided	above:	Press	the	num	lock
key	to	enable	the	numeric	keypad.	Use	Fn	key	+	NumLk	keys	to	turn	on	Num	Lock	on	laptops	without	the	numeric	keypad.Press	and	hold	the	Alt	key	and	type	224	using	the	numeric	keypad.After	typing	the	Alt	code	(i.e.	224),	release	the	[Alt]	key	you	pressed	down.	As	soon	as	you	release	the	Alt	Key,	the	Alpha	(α)	symbol	should	appear	in	your
document.	Use	the	button	below	to	copy	and	paste	the	Alpha	symbol	for	your	work.	My	favorite	method	for	inserting	symbols	is	the	copy	and	paste.	With	this	method,	all	you	need	to	do	is	google	the	symbol	you	need	to	type,	then	copy	it	from	one	of	the	search	results	provided.	Once	you	get	the	symbol	into	your	document,	you	can	always	recopy	and
paste	it	as	and	when	the	need	arises.	Use	the	button	above	to	get	this	symbol	on	your	clipboard.	There	is	another	way	to	copy	this	and	any	other	symbol	on	Windows.	It	involved	using	the	Windows	Character	Map.	Obey	the	steps	below	to	copy	and	paste	any	symbol	using	the	character	map.	Search	for	the	Character	map	app	by	clicking	on	the	Start
button.The	Character	map	app	will	show	up	in	the	search	results.	Click	on	it	to	launch.	After	the	Character	Map	window	opens	up,	click	to	check	the	Advance	View	checkbox	to	expand	the	window	for	more	advanced	options.	On	the	Advanced	View	section,	type	Alpha	Sign	in	the	search	box.The	symbol	you	searched	for	(i.e.	the	Alpha	symbol)	will	now
appear	on	the	Character	map.	Double	click	on	it	to	select	it.	You’ll	see	that	the	symbol	appears	in	the	Characters	to	copy	text	box.	This	allows	you	to	select	and	copy	several	symbols	at	the	same	time.	After	selecting	the	symbol,	you	wish	to	copy,	click	on	the	Copy	button.Switch	over	to	wherever	you	need	the	symbol,	whether	in	MS	Word,	Excel,	or
PowerPoint,	and	press	Ctrl	+	V	to	paste.	This	is	how	you	may	copy	and	paste	the	Alpha	sign	using	the	Character	Map	on	Windows.	This	approach	isn’t	as	straight	forward	as	the	shortcut	methods.	But	it’s	fairly	simple.	And	once	you	get	the	symbol	into	your	document,	you	can	always	copy	and	paste	it	again	as	and	when	you	need	it	in	your	work.	Below
are	the	steps	to	insert	the	Alpha	Sign	in	Word	using	the	insert	symbol	dialog.	On	the	Insert	tab,	click	the	Symbol	button	and	choose	More	Symbols…	These	few	clicks	will	bring	up	the	Symbol	dialog	box.	Locate	the	Symbol	you	want	to	insert.	To	easily	find	the	Alpha	symbol	on	the	Symbols	window,	look	at	the	bottom	right	area	of	the	dialog	and	type
03B1	in	the	Character	Code	box.	The	Alpha	symbol	you	want	to	insert	will	be	selected.	Once	the	symbol	is	selected,	click	on	the	Insert	button.	Alternatively,	double-clicking	on	the	symbol	will	also	insert	the	symbol	into	your	document.	This	is	how	you	may	insert	a	Alpha	symbol	in	Word	using	the	insert	symbol	dialog.	You	can	also	type	the	Alpha
Symbol	using	the	AutoCorrect	feature	in	Word.	It	is	a	feature	in	MS	Word	designed	for	correcting	spelling	mistakes	like	thsi	to	this.	Using	this	AutoCorrect	Feature,	you	can	assign	an	acronym	shortcut	to	the	Alpha	Symbol	(ALFASYM	for	example).	This	way,	whenever	you	type	the	text	ALFASYM,	Word	will	think	that	you	actually	wanted	to	type	α	and
will	convert	it	into	the	Alpha	symbol	for	you	automatically.	See	illustration	below:	What	makes	this	method	interesting	is	that	you	can	assign	your	own	custom	shortcut	or	shortcode	to	the	symbol	and	Word	will	automatically	insert	the	symbol	whenever	you	type	the	code.	Without	further	ado,	below	are	the	steps	you	can	use	to	type	Alpha	symbol	in
Word	using	AutoCorrect.	On	the	Insert	tab,	go	to	Symbol	and	then	click	More	Symbols…	The	Symbol	windows	will	appear.	Locate	the	Alpha	symbol,	then	click	to	select	it.Click	on	the	AutoCorrect…	button	to	display	the	AutoCorrect	window.In	the	AutoCorrect	dialog	box,	enter	the	following:	Replace:	ALFASYM	With:	α	Click	Add,	and	then	then	hit	the
OK	button.	Now,	word	will	automatically	insert	the	Alpha	symbol	into	your	document	whenever	you	type	ALFASYM.	However,	below	are	some	few	things	to	note	when	you	are	using	the	AutoCorrect	Method	to	insert	the	Alpha	sign.	AutoCorrect	is	case	sensitive.	Meaning	if	you	type	alfasym	(in	lowercase),	Word	will	not	convert	it	into	the	Alpha
sign	unless	you	type	ALFASYM	(in	uppercase).If	there	is	any	text	before	or	after	the	AutoCorrect	text,	Word	will	consider	the	AutoCorrect	text	as	part	of	the	text	and	hence	will	not	convert	it	to	the	Alpha	symbol.	For	example,	XALFASYM	will	not	get	converted,	but	X	ALFASYM	will	get	converted	to	X	α.	As	you	can	see,	these	are	the	various	ways	you
may	insert	or	type	the	Alpha	symbol	in	Word/Excel	with	or	without	using	the	keyboard.	My	favorite	method	is	using	the	copy	and	paste	method	followed	by	the	shortcuts.	The	Alt	Code	method	also	comes	simple.	For	any	comments	or	questions	about	this	Alpha	sign	guide,	please	let	me	know	in	the	comments	section	below.	Thanks	for	reading.	I	used
Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service
recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll
down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before
entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions	(tested	on
10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha
character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only	downsides	are
that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	Page	content	loaded	Apr	1,	2011	6:04	AM	in	response	to	DR46	Apple's	Grapher	does,	in	fact,	have	this	capability.	It's	a	shame	that	Apple's	documentation	is
very	poor.	Grapher	is	a	wonderful	application.	In	any	case,	here	is	how	to	do	it:	The	general	syntax	is:	y	=	condition(s)	?	expression	So	for	example,	if	you	only	wanted	to	graph	the	positive	x	values	of	x^2,	you	would	enter:	y	=	x	>	0	?	x^2	You	can	also	have	multiple	conditions,	separated	with	an	ampersand	(&).	For	example,	the	sinx	graph	from	-pi	to
pi:	y	=	x	>	-π	&	x	<	π	?	sinx	You	can	even	limit	the	range.	Example:	y	=	y	<	5	?	x^2	This	only	shows	the	parabola	up	to	the	y	=	5	line.	Again,	you	can	mix	and	match	any	set	of	conditions	you	desire	with	the	ampersand,	including	limits	on	the	domain	and	range	within	the	same	set	of	conditions.	Example	of	x^2	only	showing	positive	x	values	up	to	the	y
=	5	line:	y	=	y	<	5	&	x	>	0	?	x^2	Hope	this	helps.	Mar	17,	2011	4:21	PM	in	response	to	DR46	You	mean	"curve,"	not	"line."	I	think	what	you're	saying	is	that	you	want	to	graph	an	equation	such	as	y=f(x),	x>0,	but	showing	part	of	the	negative	x-axis.	I	don't	see	any	way	to	do	that	directly.	Restrict	the	x-axis	to	show	only	the	part	of	the	curve	you	want,
and	save	the	graph	as	a	TIFF.	Save	a	blank	grid	as	a	TIFF.	Composite	the	first	TIFF	onto	the	second	one	in	a	bitmap	editor.	Either	that,	or	you	need	a	much	more	flexible	graphing	program,	such	as	gnuplot.	Mar	17,	2011	2:48	PM	in	response	to	DR46	Unfortunately,	neither	of	those	answers	were	what	I'm	looking	for.	I	should	have	specified,	i	want	to
be	able	to	set	the	domain	and	range	of	a	specific	line.	I'm	looking	for	how	I	can	set	the	restrictions	to	an	equation,	I.E.	the	domain	and	range.	The	first	post	told	me	how	to	set	the	domain	and	range	of	the	axes,	but	not	of	a	line.	It	is	hard	to	communicate	exactly	what	i	mean,	but	i	hope	this	is	enough.	Thanks	for	the	answers,	anyhow.	Mar	17,	2011	3:54
PM	in	response	to	DR46	I	need	to	make	part	of	a	line	disappear	(by	setting	the	domain	and	range	of	a	line)	while	having	the	axes	remain	unaffected.	Your	first	post	altered	the	domain	and	range	of	the	axes,	while	I	need	the	domain	and	range	of	a	specific	line/parabola	to	disappear.	Feb	3,	2015	2:18	PM	in	response	to	Brad	DT	I've	been	using	grapher
for	years	&	had	*no	idea*	you	could	do	this	so	easily.	I've	wasted	so	much	time	finding	parameterizations	instead.	How	did	you	discover	this?	Do	you	know	of	a	good	manual	/	source	/	site	for	what	Grapher	can	do?	I	know	it's	very	powerful,	but	now	I'm	wondering	about	what	else	I've	been	doing	the	hard	way!	Thanks	in	advance,	Rax	Jun	28,	2016	1:06
PM	in	response	to	Linc	Davis	I	know	this	is	quite	old	but	it	came	up	in	my	search.	Is	it	possible	to	un-mark	this	as	the	answer	(appears	as	the	response	that	is	marked	as	"Solved"	in	response	to	the	OP)	since	a	later	post	from	Brad	DT	actually	gave	the	correct	answer?	And	mark	Brad	DT's	as	"Solved"?	Or	is	that	under	the	control	of	the	OP?	(I	found	the
answer	in	an	old	post	elsewhere	and	was	coming	back	to	post	it	here	when	the	full	thread	revealed	the	answer	was	here	all	along).	Mar	17,	2011	2:57	PM	in	response	to	DR46	I'm	at	a	loss	to	understand	what	you	mean.	Can	you	give	a	specific	example?	It	seems	to	me	that	your	first	example	has	already	been	addressed.	Mar	17,	2011	6:08	PM	in
response	to	DR46	oh	shoot.	that	is	my	mistake,	i	should	have	said	curve	instead	of	line.	odd	that	grapher.app	cant	set	domain	and	range,	as	it	has	so	many	other	features.	thanks	for	your	time.	Jun	29,	2016	6:59	AM	in	response	to	BTB83	The	OP	is	the	only	one	who	can	award	points.	Nov	27,	2016	9:45	AM	in	response	to	Brad	DT	Thank	you	so	much!!!
Direct	answer!	iClarified	•	May	19,	2023	at	8:27pm	You	can	easily	type	an	Alpha	symbol	(α)	on	Mac	by	pressing	Control-Command-Spacebar	on	your	keyboard	to	bring	up	the	Character	Viewer.	Search	for	'alpha'	then	select	the	symbol	to	insert	it.	Alternatively,	you	could	just	copy	and	paste	the	Alpha	symbol	(α)	from	here	to	insert	it	into	your
document.	macOS	/	Earlier	Operating	Systems	Maybe	I	am	suffering	a	lapse	here	but	I	wonder,	"How	do	I	type	characters	in	the	Greek	alphabet?"	You	know,	[alpha],	[beta],	[delta],	[gamma],	...	[psi],	[omega].	(I	used	brackets	to	mark	what	_should_	be	single	characters.)In	Pages,	the	Symbol	font	looks	_just_	like,	abcdefghijklmnopqrstuvwxyz.	While	I
heard	Rush	Limbaugh's	show	from-today,	I	tested	each	of	the	~100	[?]	fonts,	but	I	saw	_no_	Greek.	(I	couldn't	get	Greek	solidly	by	holding-down	the	[Option]	key,	either.)	iMac,	OS	X	Mountain	Lion	(10.8.4),	2.5	GHz	Intel	Core	I5	P.	&	4	GB	M.	Posted	on	Aug	22,	2013	2:39	PM	Reply	Posted	on	Aug	22,	2013	3:59	PM	2	choices:Do	Edit	>	Special
Characters	and	click	on	the	gear	wheel	at	the	top	left,	select	Customize	and	check	the	box	for	Greek.	Double	click	or	drag	drop	to	input.Go	to	system	prefs/language	&	text/input	sources	and	check	the	box	for	Greek,	plus	the	box	for	Show	Input	Menu	in	Finder.	Then	select	Greek	from	the	"flag"	menu	at	the	top	right	of	the	screen	and	type.Symbol
fonts	that	produce	Greek	when	you	type	Latin	are	obsolete	junk	and	you	should	not	use	them	if	you	happen	to	find	one.	Page	content	loaded	Aug	22,	2013	3:59	PM	in	response	to	Bob	Novy	2	choices:Do	Edit	>	Special	Characters	and	click	on	the	gear	wheel	at	the	top	left,	select	Customize	and	check	the	box	for	Greek.	Double	click	or	drag	drop	to
input.Go	to	system	prefs/language	&	text/input	sources	and	check	the	box	for	Greek,	plus	the	box	for	Show	Input	Menu	in	Finder.	Then	select	Greek	from	the	"flag"	menu	at	the	top	right	of	the	screen	and	type.Symbol	fonts	that	produce	Greek	when	you	type	Latin	are	obsolete	junk	and	you	should	not	use	them	if	you	happen	to	find	one.	Sep	2,	2013
9:39	AM	in	response	to	Bob	Novy	It	would	be	nice	if	you	could	re-assign	the	option+key	(e.g.	option	+	a	=	alpha),	but	I	haven't	found	a	way.	What	I	have	done	instead	is	do	as	Tom	said,	then	just	map	a	keyboard	shortcut	to	change	between	inputs	(I'm	using	ctrl+space):Setup	keyboard	shortcut:	"system	preferences->keyboard->input	Sources-
>Language"	then	enable	the	"select	previous	input	source"	(last	one	on	my	list),	change	the	shortcut	as	needed.Though	(as	you	might	know?)	for	a	few	of	them,	you	already	have	dedicated	shortcuts	(just	not	all	the	ones	I	need,	but	you	might	be	lucky?):Greek16	∂	Option-D	(Delta)	)17	∆	Option-J	(Delta)18	µ	Option-M	(Mu)19	π	Option-P	(phi)20	ß
Option-S	(beta21	Ω	Option-Z	(Omega)22	∏	Option-Shift-P	(phi)Found	here:	creating-symbols.html)Cheers,W	Sep	2,	2013	10:28	AM	in	response	to	2352	2352	wrote:	It	would	be	nice	if	you	could	re-assign	the	option+key	(e.g.	option	+	a	=	alpha),	but	I	haven't	found	a	way.	One	way	is	to	build	a	custom	keyboard	layout	using	s	really	very	easy.	Sep	11,
2013	8:19	AM	in	response	to	2352	Thank	you,	Tom	Gewecke	out	in	far-from	NC,	Scottsdale,	AZ.	Still,	I	wonder	why	Apple	no-longer	provides	a	Proper	Symbol	font?On	my	iMac	with	System	OS	X	v10.8.4,	what	Apple	calls	Symbol	is	just	Arabic	(regular	a-z	&	A-Z)	in	what	looks	like	Helvetica	font.	What	mis-advertising!	I	would	Expect	better	from	Apple
than	this.	Apple	has	regressed,	yes?Still	were	I	a	skeptic,	I	would	think	that	a	Greek	font	is	something	that	Apple	plans	to	release	in-the	future,	again.	Upgrade	=	More	Money!	:-(So	I	thank	goodness	that	_I_	don't	use	Greek	font,	today.	But	I	remember	when	I	did.In	Graduate	School,	I	relied	on	Troff,	the	word	processor	on	the	UNIX	Operating	System.
Through	more	than	5-years	of	study	at	the	University	of	Minnesota,	I	wrote	my	PhD	thesis	with	Troff,	finishing	in	1990.	:-)	Sep	11,	2013	9:14	AM	in	response	to	Bob	Novy	Bob	Novy	wrote:	Apple	has	regressed,	yes?No,	Apple	has	progressed,	and	the	other	way	is	stuck	in	the	1990's.	Everyone	should	be	using	Unicode,	where	Greek	characters	have	their
own	code	points.	Fonts	like	the	old	Symbol	which	map	Greek	to	Latin	codepoints	are	obsolete	and	hopefully	will	disappear.	Apple's	Symbol	font	puts	things	where	they	are	supposed	to	be	under	the	agreed	international	standards.	It	is	really	unfortunate	that	we	have	so	much	legacy	data	which	was	done	the	old	way....Apple	could	provide	a	second
"improper"	Symbol	font	to	help	people	deal	with	that,	but	has	chosen	not	to.	This	thread	has	been	closed	by	the	system	or	the	community	team.	You	may	vote	for	any	posts	you	find	helpful,	or	search	the	Community	for	additional	answers.	Unlock	the	full	potential	of	your	Mac	keyboard	by	mastering	the	use	of	special	characters.	Here	are	three	easy
methods	to	access	myriad	symbols	in	nearly	every	application.	Typing	special	characters	on	a	Mac	is	straightforward	once	you	understand	the	methods	available.	Whether	it's	accent	marks,	currency	symbols,	or	mathematical	notations,	this	guide	will	walk	you	through	three	primary	techniques	to	access	special	characters	on	your	Mac.	How	to	press
and	hold	a	key	to	type	special	characters	on	MacThis	method	is	good	when	you	know	the	special	character	is	a	modified	letter:	Position	your	cursor	where	you	want	the	character	to	appear.	Press	and	hold	the	key	corresponding	to	the	character	you	want.	For	example,	to	type	'e'	with	an	acute,	press	and	hold	the	'e'	key.	A	small	menu	will	pop	up,
showing	different	variations	of	the	character.	While	still	holding	the	key,	either	click	the	character	you	want	or	press	the	number	corresponding	to	the	character.	Each	keyboard	key	has	a	set	of	modified	versions	from	which	to	choose.How	to	use	the	Option	key	to	type	special	characters	on	MacThis	method	is	is	the	fastest	when	typing,	but	is	limited
to	a	single	character	per	keyboard	key:	Position	your	cursor	where	you	want	the	character	to	appear.	Hold	down	the	'Option'	key.	While	holding	the	'Option'	key,	press	another	key	to	create	a	special	character.	For	example,	'Option	+	a'	will	produce	an	'a'	with	an	overring.	Release	the	keys.	Like	the	'Shift'	key,	the	'Option'	key	modifies	each	letter.	The
letter	'a'	gets	an	overring.How	to	access	the	Character	Viewer	to	type	special	characters	on	MacThe	Character	Viewer	is	a	tool	that	provides	a	wide	range	of	special	characters:	Position	your	cursor	where	you	want	the	character	to	appear.	Go	to	the	'Edit'	menu	on	the	application	you	are	using.	Select	'Emoji	&	Symbols'	from	the	drop-down	menu,	or
use	the	shortcut	'Control	+	Command	+	Space'.	The	Character	Viewer	will	appear,	displaying	a	variety	of	characters.	Navigate	through	the	viewer,	select	the	character	you	want,	and	it	will	be	inserted	into	your	document.	In	addition	to	emoji,	the	Character	Viewer	is	where	you	can	find	pretty	much	any	character.Each	of	these	methods	offers	a	way	to
access	special	characters	quickly	and	efficiently,	making	it	easier	to	convey	precise	information	in	your	documents,	emails,	or	any	other	text	on	your	Mac.	I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best
single-keystroke	method	I	found	for	such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and
Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo
(I	used	command-option-shift-A).	The	only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	MagicPlot	supports	any	Unicode	symbols,	including	Greek	letters	and	many	special	symbols.	The
help	on	inserting	Greek	letters	and	special	symbols	is	also	available	in	Help	menu.	To	insert	Greek	letter	type	Ctrl+G	(Command	G	on	Mac	OS)	and	then	type	Latin	letter	mentioned	in	the	table	below.	Greek	Letter	Name	Greek	Symbol	On	Keyboard	(Ctrl+G,	then)	Alpha	Α	α	A	a	Beta	Β	β	B	b	Gamma	Γ	γ	G	g	Delta	Δ	δ	D	d	Epsilon	Ε	ε	E	e	Zeta	Ζ	ζ	Z	z	Eta
Η	η	H	h	Theta	Θ	θ	Q	q	Theta	(alt.)	ϑ	J	Iota	Ι	ι	I	i	Kappa	Κ	κ	K	k	Lambda	Λ	λ	L	l	Mu	Μ	μ	M	m	Nu	Ν	ν	N	n	Xi	Ξ	ξ	X	x	Omicron	Ο	ο	O	o	Pi	Π	π	P	p	Rho	Ρ	ρ	R	r	Sigma	Σ	σ	S	s	Tau	Τ	τ	T	t	Upsilon	Υ	υ	U	u	Phi	Φ	φ	F	f	Phi	(alt.)	ϕ	j	Chi	Χ	χ	C	c	Psi	Ψ	ψ	Y	y	Omega	Ω	ω	W	w	To	insert	math	symbol	type	Ctrl+M	(Command	M	on	Mac	OS)	and	then	type	symbol
mentioned	in	the	table	below.	Symbol	name	Symbol	On	Keyboard	(Ctrl+M,	then)	Multiplication	sign	×	*	or	x	Middle	dot	(multiplication)	·	.	(dot)	Division	slash	∕	/	Minus	sign	−	-	Plus-minus	sign	±	+	Minus-plus	sign	∓	=	Not	equal	≠	n	Infinity	∞	8	To	see	the	full	list	of	shortcuts	select	Help	→	Insert	Greek	Letters	and	Math	menu	item.	To	insert	the
following	special	characters,	simply	type	character	sequences,	as	shown	in	the	table	below.	Character	sequences	will	be	replaced	with	special	characters	when	you	exit	the	edit	mode	(but	only	if	selected	font	contains	required	symbols).	You	can	disable	auto	replacing	in	Typography	tab	of	MagicPlot	Preferences.	Symbol	name	Symbol	Char	sequence
Em	dash	—	---	En	dash	–	--	Ellipsis	…	...	Much	less	than	≪	>	Less	than	or	equal	to	≤	=	Plus-minus	sign	±	+/-	Minus-plus	sign	∓	-/+	MagicPlot	shows	in	status	bar	the	Unicode	code	point	of	character	highlighted	in	text	label.	To	view	code	point	select	exactly	one	character	in	text	label	in	Figure	of	Fit	Plot.	Advanced	Typography	Features	Mac	/	MacBook
Pro	Hi	all,I	am	trying	to	find	a	shortcut	for	lambda	but	i	found	other	greek	laters	by	using	option	key.	I	can	type	µ.	Thank	you,	Vanessa	MacBook	Pro	Posted	on	Aug	16,	2012	2:57	PM	Reply	Posted	on	Aug	16,	2012	5:28	PM	You	can	only	type	a	few	Greek	characters	using	the	US	keyboard	layout.	Instead	use	the	Character	Palette	or	activate	the	Greek
keyboard	layout.	You	should	check	the	boxes	for	these	in	system	prefs/language	&	text/input	sources,	plus	the	box	for	Show	Input	Menu	in	Menu	Bar.You	can	access	Character	Palette	via	Edit	>	Special	CharactersYou	can	access	the	Greek	Keyboard	by	selecting	it	in	the	"flag"	menu	at	the	top	right	of	the	screen.	Select	Keyboard	Viewer	from	the	same
menu	to	see	which	key	does	what.	Page	content	loaded	Aug	16,	2012	5:28	PM	in	response	to	aguilsv	You	can	only	type	a	few	Greek	characters	using	the	US	keyboard	layout.	Instead	use	the	Character	Palette	or	activate	the	Greek	keyboard	layout.	You	should	check	the	boxes	for	these	in	system	prefs/language	&	text/input	sources,	plus	the	box	for
Show	Input	Menu	in	Menu	Bar.You	can	access	Character	Palette	via	Edit	>	Special	CharactersYou	can	access	the	Greek	Keyboard	by	selecting	it	in	the	"flag"	menu	at	the	top	right	of	the	screen.	Select	Keyboard	Viewer	from	the	same	menu	to	see	which	key	does	what.	This	thread	has	been	closed	by	the	system	or	the	community	team.	You	may	vote
for	any	posts	you	find	helpful,	or	search	the	Community	for	additional	answers.	What	is	the	shortcut	for	greek	letters.	Alt	code	shortcuts	are	popular	in	Windows	PC	to	insert	special	characters	and	Unicode	symbols.	Many	users	do	not	know	that	they	can	also	use	alt	code	shortcuts	in	Apple’s	MacBook	and	iMac	computers.	The	default	Apple	keyboard
also	has	two	alt	keys	on	the	keyboard	layout.	They	are	named	as	“Option”	on	the	keys	with	the	small	name	“alt”	on	it.	These	alt	keys	are	one	of	the	hidden	gems	in	Apple	keyboard	less	used	by	most	of	the	Mac	users.	In	this	article,	we	will	provide	a	complete	list	alt	code	shortcuts	for	Mac	to	insert	symbols.	You	can	use	the	option	key	to	insert	special
symbols	like	trademark,	copyright	and	currencies.	These	alt	code	Mac	shortcuts	will	work	on	all	default	text	editing	apps	like	Pages,	Numbers,	Keynote,	Notes,	TextEdit	or	when	typing	emails.	You	can	use	the	default	English	keyboard	layout	(ABC)	when	using	alt	key	with	other	modifier	keys	like	Shift	or	letter	keys.	However,	you	should	change	the
input	source	to	Unicode	Hex	Input	in	order	to	use	the	four	digit	hexadecimal	Unicode	points.	Below	is	the	complete	list	of	keyboard	shortcuts	for	inserting	symbols	using	option	or	alt	key	in	macOS.	Use	the	search	box	for	typing	the	symbol	name	to	quickly	filter	the	results.	For	example,	type	“cross”	to	filter	all	cross	mark	symbols.	We	have	also
grouped	the	shortcuts	under	different	categories	and	you	can	sort	the	“Category”	column	to	find	relevant	shortcuts	easily.	Accent	–	accented	language	characters	like	Ä,	ë	and	Ǖ.	Arrows	–	all	arrow	symbols	like	➘,	➜	and	➵.	Check	–	check	mark	symbols	in	Mac	like	☑	and	✔.	Cross	–	cross	symbols	like	✖	and	☒.	Currency	–	all	currency	symbols	like	€,	$
and	£.	Hearts	–	different	hearts	symbols	like	❤	and	♥.	Letters	–	default	keyboard	uppercase	and	lowercase	letters.	Math	–	mathematical	symbols,	fractions	and	operators	like	≤,	≥	and	≠.	Music	–	music	symbols	like	♫	and	♯.	Numbers	–	default	and	circled	numbers	like	❶	and	➉.	Punctuation	–	typography	marks	like	¶	and	¿.	Sports	–	sports	and	activities
related	symbols	like	♧	and	♞.	Stars	–	star	and	asterisk	symbols	like	,	✰	and	✪.	Symbol	–	special	and	letter	like	symbols	like	©,	™	and	✐.	Weather	–	nature	related	symbols	like	❄,	☃	and	☂.	Zodiac	–	astrology	symbols	like	♌	and	♏.	Mac	Alt	CodeSymbolDescriptionCategory	Option	+	Shift	+	kApple	Logo	SymbolSymbol	Option	+	zΩOhm	or	OmegaMath
Option	+	pπGreek	Lowercase	PiMath	Option	+	mµMicron	or	Micro	SignMath	Option	+	Shift	+	;ÚLatin	Uppercase	U	with	AcuteAccent	Option	+	2™TrademarkSymbol	Option	+	sßLatin	Lowercase	Sharp	SLetters	Option	+	Shift	+	qŒLatin	Uppercase	Ligature	OELetters	Option	+	qœLatin	Lowercase	Ligature	OELetters	Option	+	Shift	+	oØLatin
Uppercase	O	with	StrokeLetters	Option	+	oøLatin	Lowercase	O	with	StrokeLetters	Option	+	Shift	+	jÔLatin	Uppercase	O	with	CircumflexAccent	Option	+	Shift	+	lÒLatin	Uppercase	O	with	GraveAccent	Option	+	Shift	+	hÓLatin	Uppercase	O	with	AcuteAccent	Option	+	0ºMasculine	Ordinal	IndicatorMath	Option	+	Shift	+	bıLatin	Lowercase	Dotless
ILetters	Option	+	Shift	+	fÏLatin	Uppercase	I	with	DiaeresisAccent	Option	+	Shift	+	dÎLatin	Uppercase	I	with	CircumflexAccent	Option	+	Shift	+	sÍLatin	Uppercase	I	with	AcuteAccent	Option	+	fƒLatin	Lowercase	f	with	Hook	or	FlorinLetters	Option	+	Shift	+	6flLatin	Lowercase	Ligature	FLLetters	Option	+	Shift	+	5fiLatin	Lowercase	Ligature
FILetters	Option	+	Shift	+	cÇLatin	Uppercase	C	with	CedillaAccent	Option	+	cçLatin	Lowercase	C	with	CedillaAccent	Option	+	Shift	+	‘ÆLatin	Uppercase	ÆLetters	Option	+	‘æLatin	Lowercase	æLetters	Option	+	Shift	+	aÅLatin	Uppercase	A	with	Ring	AboveAccent	Option	+	aåLatin	Lowercase	A	with	Ring	AboveAccent	Option	+	Shift	+	mÂLatin
Uppercase	A	with	CircumflexAccent	Option	+	Shift	+	yÁLatin	Uppercase	A	with	AcuteAccent	Option	+	9ªFeminine	Ordinal	IndicatorMath	Option	+	Shift	+	2€Euro	SymbolCurrency	Option	+	y¥Japanese	Yen	SymbolCurrency	Option	+	3£Pound	Sterling	SymbolCurrency	Option	+	4¢Cent	SymbolCurrency	Option	+	Shift	+	v◊Diamond	or	LozengeMath
Option	+	.≥Greater	than	or	Equal	toMath	Option	+	,≤Lesser	than	or	Equal	toMath	Option	+	x≈Approximate	or	Almost	Equal	toMath	Option	+	b∫Integral	SymbolMath	Option	+	5∞InfinityMath	Option	+	v√Square	Root	Math	SymbolMath	Option	+	Shift	+	1⁄Slash	or	Forward	Slash	or	Right	SlashPunctuation	Option	+	l¬Not	SignMath	Option	+	=≠Not
Equal	toMath	Option	+	/÷Divided	by	or	Division	SignMath	Option	+	Shift	+	=±Plus	or	MinusMath	Option	+	w∑Sigma	or	Sum	or	N-ary	SummationMath	Option	+	Shift	+	p∏N-ary	product	SymbolMath	Option	+	j∆Triangle	or	IncrementMath	Option	+	d∂Partial	DifferentialMath	Option	+	r®RegisteredSymbol	Option	+	g©CopyrightSymbol	Option	+
Shift	+	8°DegreeMath	Option	+	Shift	+	tˇCaron	or	háček	or	Inverted	CircumflexAccent	Option	+	Shift	+	iˆCircumflexAccent	Option	+	iˆCircumflexAccent	Option	+	Shift	+	x˛OgonekAccent	Option	+	Shift	+	z¸CedillaAccent	Option	+	Shift	+	g˝Double	Acute	AccentAccent	Option	+	k˚Ring	AboveAccent	Option	+	u¨DiaeresisAccent	Option	+	Shift	+
u¨DiaeresisAccent	Option	+	h˙Superscript	Dot	or	Dot	AboveAccent	Option	+	Shift	+	.˘BreveAccent	Option	+	Shift	+	,¯MacronAccent	Option	+	Shift	+	n˜Lowercase	TildeAccent	Option	+	n˜Lowercase	TildeAccent	Option	+	Shift	+	e´Acute	AccentAccent	Option	+	e´Acute	AccentAccent	Option	+	8•BulletPunctuation	Option	+	Shift	+	7‡Double
DaggerCross	Option	+	t†Dagger	or	Plus	or	CrossCross	Option	+	Shift	+	r‰Per	Mille	SignMath	Option	+	7¶Paragraph	or	Pilcrow	signPunctuation	Option	+	6§Section	SignPunctuation	Option	+	Shift	+	\»Double	Right	Angle	Quotation	MarkPunctuation	Option	+	\«Double	Left	Angle	Quotation	MarkPunctuation	Option	+	Shift	+	w„Double	Quote
(European)Punctuation	Option	+	Shift	+	[”Right	Double	QuotePunctuation	Option	+	[“Left	Double	QuotePunctuation	Option	+	Shift	+	4›Single	Right	Angle	Quotation	MarkPunctuation	Option	+	Shift	+	3‹Single	Left	Angle	Quotation	MarkPunctuation	Option	+	Shift	+	0‚CommaPunctuation	Option	+	Shift	+	]’Right	Single	QuotePunctuation	Option	+
]‘Apostrophe	or	Left	Single	QuotePunctuation	Option	+	Shift	+	9·Dot	CenterPunctuation	Option	+	;…Horizontal	EllipsisPunctuation	Option	+	Shift	+	/¿Inverted	Question	MarkPunctuation	Option	+	1¡Inverted	Exclamation	MarkPunctuation	Option	+	Shift	+	-—Em	DashPunctuation	Option	+	-–En	DashPunctuation	Option	+	001E‑HyphenPunctuation
Option	+	0021!ExclamationPunctuation	Option	+	0022“Double	QuotePunctuation	Option	+	0023#Number	SignPunctuation	Option	+	0024$Dollar	SignCurrency	Option	+	0025%PercentagePunctuation	Option	+	0026&AmpersandPunctuation	Option	+	0027‘Single	QuotePunctuation	Option	+	0028(Left	ParenthesisPunctuation	Option	+	0029)Right
ParenthesisPunctuation	Option	+	002A*AsteriskPunctuation	Option	+	002B+Plus	SignMath	Option	+	002C,CommaPunctuation	Option	+	002D-MinusMath	Option	+	002E.Full	stopPunctuation	Option	+	002F/Right	SlashPunctuation	Option	+	00300Number	ZeroNumbers	Option	+	00311Number	OneNumbers	Option	+	00322Number	TwoNumbers
Option	+	00333Number	ThreeNumbers	Option	+	00344Number	FourNumbers	Option	+	00355Number	FiveNumbers	Option	+	00366Number	SixNumbers	Option	+	00377Number	SevenNumbers	Option	+	00388Number	EightNumbers	Option	+	00399Number	NineNumbers	Option	+	003A:ColonPunctuation	Option	+	003B;SemicolonPunctuation
Option	+	003CLess	thanMath	Option	+	003D=Is	Equal	toMath	Option	+	003E>	Greater	thanMath	Option	+	003F?Question	MarkPunctuation	Option	+	0040@At	the	RateSymbol	Option	+	0041AUppercase	ALetters	Option	+	0042BUppercase	BLetters	Option	+	0043CUppercase	CLetters	Option	+	0044DUppercase	DLetters	Option	+	0045EUppercase
ELetters	Option	+	0046FUppercase	FLetters	Option	+	0047GUppercase	GLetters	Option	+	0048HUppercase	HLetters	Option	+	0049IUppercase	ILetters	Option	+	004AJUppercase	JLetters	Option	+	004BKUppercase	KLetters	Option	+	004CLUppercase	LLetters	Option	+	004DMUppercase	MLetters	Option	+	004ENUppercase	NLetters	Option	+
004FOUppercase	OLetters	Option	+	0050PUppercase	PLetters	Option	+	0051QUppercase	QLetters	Option	+	0052RUppercase	RLetters	Option	+	0053SUppercase	SLetters	Option	+	0054TUppercase	TLetters	Option	+	0055UUppercase	ULetters	Option	+	0056VUppercase	VLetters	Option	+	0057WUppercase	WLetters	Option	+	0058XUppercase
XLetters	Option	+	0059YUppercase	YLetters	Option	+	005AZUppercase	ZLetters	Option	+	005B[Left	BracketPunctuation	Option	+	005C\Left	SlashPunctuation	Option	+	005D]Right	BracketPunctuation	Option	+	005E^CapPunctuation	Option	+	005F_UnderscorePunctuation	Option	+	0060`ApostrophePunctuation	Option	+	0061aLowercase	aLetters
Option	+	0062bLowercase	bLetters	Option	+	0063CLowercase	cLetters	Option	+	0064dLowercase	dLetters	Option	+	0065ELowercase	eLetters	Option	+	0066fLowercase	fLetters	Option	+	0067gLowercase	gLetters	Option	+	0068hLowercase	hLetters	Option	+	0069iLowercase	iLetters	Option	+	006AjLowercase	jLetters	Option	+	006BkLowercase
kLetters	Option	+	006ClLowercase	lLetters	Option	+	006DmLowercase	mLetters	Option	+	006EnLowercase	nLetters	Option	+	006FoLowercase	oLetters	Option	+	0070pLowercase	pLetters	Option	+	0071qLowercase	qLetters	Option	+	0072rLowercase	rLetters	Option	+	0073sLowercase	sLetters	Option	+	0074tLowercase	tLetters	Option	+
0075uLowercase	uLetters	Option	+	0076vLowercase	vLetters	Option	+	0077wLowercase	wLetters	Option	+	0078xLowercase	xLetters	Option	+	0079yLowercase	yLetters	Option	+	007AzLowercase	zLetters	Option	+	007B{Left	Brace	or	Curly	BracketPunctuation	Option	+	007C|PipelinePunctuation	Option	+	007D}Right	Brace	or	Curly
BracketPunctuation	Option	+	007E~Intermediate	or	ApproximatePunctuation	Option	+	0080€Euro	CurrencyCurrency	Option	+	0083ƒDutch	FlorinCurrency	Option	+	0085…Three	dots	continuationPunctuation	Option	+	0086†DaggerCross	Option	+	0087‡Double	DaggerCross	Option	+	0088ˆCap	ArrowSymbol	Option	+	0089‰Per	MilleMath	Option	+
008AŠUppercase	S	with	CaronAccent	Option	+	008B‹Single	Angle	Quotation	LeftPunctuation	Option	+	008CŒUppercase	O-E	LigatureLetters	Option	+	008EŽUppercase	Z	with	CaronAccent	Option	+	0095•Big	DotPunctuation	Option	+	0096–En-dash	symbolPunctuation	Option	+	0097—Em-dash	symbolPunctuation	Option	+
0098˜IntermediateSymbol	Option	+	0099™TrademarkSymbol	Option	+	009AšLowercase	s	with	CaronAccent	Option	+	009B›Single	Angle	Quotation	RightPunctuation	Option	+	009CœLowercase	o-e	LigatureLetters	Option	+	009EžLowercase	z	with	CaronAccent	Option	+	009FŸUmlaut	Y	UppercaseAccent	Option	+	00A1¡Down	Exclamation
MarkPunctuation	Option	+	00A2¢CentCurrency	Option	+	00A3£PoundCurrency	Option	+	00A4¤General	CurrencyCurrency	Option	+	00A5¥Japanese	YenCurrency	Option	+	00A6¦Pipeline	with	BreakPunctuation	Option	+	00A7§Section	SymbolPunctuation	Option	+	00A9©CopyrightSymbol	Option	+	00AAªFeminine	Ordinal	NumberMath	Option	+
00AB«Double	Angle	Quotation	LeftPunctuation	Option	+	00AC¬Not	SymbolMath	Option	+	00AD​Hyphen	or	DashPunctuation	Option	+	00AE®RegisteredSymbol	Option	+	00AF¯Upper	DashPunctuation	Option	+	00B0°Degree	SignMath	Option	+	00B1±Plus	or	Minus	SignMath	Option	+	00B2²Power	of	Two	(Square)Math	Option	+	00B3³Power	of	Three
(Cube)Math	Option	+	00B5µMicronMath	Option	+	00B6¶ParagraphPunctuation	Option	+	00B7·Center	DotPunctuation	Option	+	00B9¹Citation	OnePunctuation	Option	+	00BAºMasculine	Ordinal	NumberMath	Option	+	00BB»Double	Angle	Quotation	RightPunctuation	Option	+	00BB»Double	Greater	than	MarkPunctuation	Option	+	00BC¼One	fourth
fractionMath	Option	+	00BD½One	half	fractionMath	Option	+	00BE¾Three	fourth	fractionMath	Option	+	00BF¿Down	Question	MarkPunctuation	Option	+	00C0ÀLatin	Grave	A	UppercaseAccent	Option	+	00C1ÁLatin	Acute	A	UppercaseAccent	Option	+	00C2ÂLatin	Circumflex	A	UppercaseAccent	Option	+	00C3ÃLatin	Tilde	A	UppercaseAccent
Option	+	00C4ÄLatin	Umlaut	A	UppercaseAccent	Option	+	00C5ÅLatin	Uppercase	A	with	Ring	AboveAccent	Option	+	00C6ÆLatin	Uppercase	A-E	LigatureLetters	Option	+	00C7ÇLatin	Uppercase	C	CedillaAccent	Option	+	00C8ÈLatin	Grave	E	UppercaseAccent	Option	+	00C9ÉLatin	Acute	E	UppercaseAccent	Option	+	00CAÊLatin	Circumflex	E
UppercaseAccent	Option	+	00CBËLatin	Umlaut	E	UppercaseAccent	Option	+	00CCÌLatin	Grave	I	UppercaseAccent	Option	+	00CDÍLatin	Acute	I	UppercaseAccent	Option	+	00CEÎLatin	Circumflex	I	UppercaseAccent	Option	+	00CFÏLatin	Umlaut	I	UppercaseAccent	Option	+	00D0ÐOld	English	Eth	(Uppercase)Letters	Option	+	00D1ÑLatin	Tilde	I
UppercaseAccent	Option	+	00D2ÒLatin	Grave	O	UppercaseAccent	Option	+	00D3ÓLatin	Acute	O	UppercaseAccent	Option	+	00D4ÔLatin	Circumflex	O	UppercaseAccent	Option	+	00D5ÕLatin	Tilde	O	UppercaseAccent	Option	+	00D6ÖLatin	Umlaut	O	UppercaseAccent	Option	+	00D7×Multiplication	SignMath	Option	+	00D8ØUppercase	Nordic	O
SlashLetters	Option	+	00D8ØPhiMath	Option	+	00D9ÙLatin	Grave	U	UppercaseAccent	Option	+	00DAÙLatin	Acute	U	UppercaseAccent	Option	+	00DBÛLatin	Circumflex	U	UppercaseAccent	Option	+	00DCÜLatin	Umlaut	U	UppercaseAccent	Option	+	00DDÝLatin	Acute	Y	UppercaseAccent	Option	+	00DEÞOld	English	Thorn	(Uppercase)Letters
Option	+	00DFßGerman	Sharp	SLetters	Option	+	00E0àLatin	Grave	a	LowercaseAccent	Option	+	00E1áLatin	Acute	a	LowercaseAccent	Option	+	00E2âLatin	Circumflex	a	LowercaseAccent	Option	+	00E3ãLatin	Tilde	a	LowercaseAccent	Option	+	00E4äLatin	Umlaut	a	LowercaseAccent	Option	+	00E5åLatin	Lowercase	a	with	Ring	AboveLetters
Option	+	00E6æLatin	Lowercase	a-e	LigatureLetters	Option	+	00E7çLatin	Lowercase	C	CedillaAccent	Option	+	00E8èLatin	Grave	e	LowercaseAccent	Option	+	00E9éLatin	Acute	e	LowercaseAccent	Option	+	00EAêLatin	Circumflex	e	LowercaseAccent	Option	+	00EBëLatin	Umlaut	e	LowercaseAccent	Option	+	00ECìLatin	Grave	i	LowercaseAccent
Option	+	00EDíLatin	Acute	i	LowercaseAccent	Option	+	00EEîLatin	Circumflex	i	LowercaseAccent	Option	+	00EFïLatin	Umlaut	i	LowercaseAccent	Option	+	00F0ðOld	English	Eth	(Lowercase)Letters	Option	+	00F1ñLatin	Tilde	i	LowercaseAccent	Option	+	00F2òLatin	Grave	o	LowercaseAccent	Option	+	00F3óLatin	Acute	o	LowercaseAccent	Option
+	00F4ôLatin	Circumflex	o	LowercaseAccent	Option	+	00F5õLatin	Tilde	o	LowercaseAccent	Option	+	00F6öLatin	Umlaut	o	LowercaseAccent	Option	+	00F7÷Division	SignMath	Option	+	00F8øLatin	Lowercase	O	with	StrokeLetters	Option	+	00F9ùLatin	Grave	u	LowercaseAccent	Option	+	00FAúLatin	Acute	u	LowercaseAccent	Option	+	00FBûLatin
Circumflex	u	LowercaseAccent	Option	+	00FCüLatin	Umlaut	u	LowercaseAccent	Option	+	00FDýLatin	Acute	y	LowercaseAccent	Option	+	00FEþOld	English	Thorn	(Lowercase)Letters	Option	+	00FFÿLatin	Umlaut	y	LowercaseAccent	Option	+	2710✐PencilSymbol	Option	+	2711✑White	NibSymbol	Option	+	2712✒Black	NibSymbol	Option	+
2713✓Tick	MarkCheck	Option	+	2714✔Bold	Tick	MarkCheck	Option	+	2715✕Cross	MarkCross	Option	+	2716✖Bold	Cross	MarkCross	Option	+	2717✗Styled	Cross	MarkCross	Option	+	2718✘Bold	Style	Cross	MarkCross	Option	+	2719✙Embossed	PlusCross	Option	+	271A✚Bold	PlusCross	Option	+	271B✛CursorCross	Option	+	271C✜Bold
CursorCross	Option	+	271D✝Simple	CrossCross	Option	+	271E✞Jesus	CrossCross	Option	+	271F✟Embossed	CrossCross	Option	+	2720✠Maltese	CrossCross	Option	+	2721✡Six	Star	(Star	of	David)Stars	Option	+	2722✢Four	Teardrop	Spoked	AsteriskStars	Option	+	2723✣Four	Balloon	Spoked	AsteriskStars	Option	+	2724✤Bold	Four	Balloon	Spoked
AsteriskStars	Option	+	2725✥Four	Clubs	Spoked	AsteriskStars	Option	+	2726✦Black	Four	Pointed	StarStars	Option	+	2727✧White	Four	Pointed	StarStars	Option	+	2728SparklesStars	Option	+	2729✩Five	Pointed	StarStars	Option	+	272A✪Five	Pointed	Star	in	CircleStars	Option	+	272B✫White	Center	Black	StarStars	Option	+	272C✬Black	Center
White	StarStars	Option	+	272D✭Outlined	Black	StarStars	Option	+	272E✮Bold	Outlined	Black	StarStars	Option	+	272F✯Pinwheel	StarStars	Option	+	2730✰White	Star	with	ShadowStars	Option	+	2731✱Bold	AsteriskStars	Option	+	2732✲Open	Center	AsteriskStars	Option	+	2733✳Eight	Spoked	AsteriskStars	Option	+	2734✴Eight	Point	Black
StarStars	Option	+	2735✵Eight	Point	Pinwheel	StarStars	Option	+	2736✶Six	Point	Black	StarStars	Option	+	2737✷Eight	Point	Rectilinear	Black	StarStars	Option	+	2738✸Bold	Eight	Point	Rectilinear	Black	StarStars	Option	+	2739✹Twelve	Point	Black	StarStars	Option	+	273A✺Sixteen	Spoked	AsteriskStars	Option	+	273D✽FlowerStars	Option	+
2742❂Flower	DonutSymbol	Option	+	2744❄SnowflakeWeather	Option	+	2751❑Lower	Right	Shadowed	White	SquareSymbol	Option	+	2763❣Heavy	Heart	Exclamation	MarkHearts	Option	+	2764❤Heavy	Black	HeartHearts	Option	+	2765❥Rotated	Heavy	Black	Heart	BulletHearts	Option	+	2766❦Floral	HeartHearts	Option	+	2767❧Rotated	Floral
Heart	BulletHearts	Option	+	2776❶Negative	Circled	Digit	OneNumbers	Option	+	2777❷Negative	Circled	Digit	TwoNumbers	Option	+	2778❸Negative	Circled	Digit	ThreeNumbers	Option	+	2779❹Negative	Circled	Digit	FourNumbers	Option	+	277A❺Negative	Circled	Digit	FiveNumbers	Option	+	277B❻Negative	Circled	Digit	SixNumbers	Option	+
277C❼Negative	Circled	Digit	SevenNumbers	Option	+	277D❽Negative	Circled	Digit	EightNumbers	Option	+	277E❾Negative	Circled	Digit	NineNumbers	Option	+	277F❿Negative	Circled	Digit	TenNumbers	Option	+	2780➀Circled	Sans-serif	Digit	OneNumbers	Option	+	2781➁Circled	Sans-serif	Digit	TwoNumbers	Option	+	2782➂Circled	Sans-serif
Digit	ThreeNumbers	Option	+	2783➃Circled	Sans-serif	Digit	FourNumbers	Option	+	2784➄Circled	Sans-serif	Digit	FiveNumbers	Option	+	2785➅Circled	Sans-serif	Digit	SixNumbers	Option	+	2786➆Circled	Sans-serif	Digit	SevenNumbers	Option	+	2787➇Circled	Sans-serif	Digit	EightNumbers	Option	+	2788➈Circled	Sans-serif	Digit	NineNumbers
Option	+	2789➉Circled	Sans-serif	Digit	TenNumbers	Option	+	2798➘Bold	South	East	ArrowArrows	Option	+	2799➙Bold	Right	ArrowArrows	Option	+	279A➚Bold	North	East	ArrowArrows	Option	+	279B➛Drafting	Point	Right	ArrowArrows	Option	+	279C➜Bold	Round	Tipped	Right	ArrowArrows	Option	+	279D➝Triangle	Head	Right	ArrowArrows
Option	+	279E➞Bold	Triangle	Head	Right	ArrowArrows	Option	+	279F➟Dashed	Triangle	Head	Right	ArrowArrows	Option	+	27A0➠Bold	Dashed	Triangle	Head	Right	ArrowArrows	Option	+	27A1➡Black	Right	ArrowArrows	Option	+	27A2➢3D	Top	Lighted	Right	ArrowArrows	Option	+	27A3➣3D	Bottom	Lighted	Right	ArrowArrows	Option	+
27A4➤Black	Right	Arrow	HeadArrows	Option	+	27A5➥Bold	Down	Curved	Right	ArrowArrows	Option	+	27A6➦Bold	Up	Curved	Right	ArrowArrows	Option	+	27A7➧Squat	Right	ArrowArrows	Option	+	27A8➨Bold	Concave	Black	Right	ArrowArrows	Option	+	27A9➩Right	Shadowed	White	Right	ArrowArrows	Option	+	27AA➪Left	Shadowed	White	Right
ArrowArrows	Option	+	27AB➫Back	Tilted	Shadowed	White	Right	ArrowArrows	Option	+	27AC➬Front	Tilted	Shadowed	White	Right	ArrowArrows	Option	+	27AD➭Bold	Lower	Shadowed	White	Right	ArrowArrows	Option	+	27AE➮Bold	Upper	Shadowed	White	Right	ArrowArrows	Option	+	27AF➯Notched	Lower	Shadowed	White	Right	ArrowArrows
Option	+	27B0Curly	LoopSymbol	Option	+	27B1➱Notched	Upper	Shadowed	White	Right	ArrowArrows	Option	+	27B2➲Circled	Bold	White	Right	ArrowArrows	Option	+	27B3➳White	Feathered	Right	ArrowArrows	Option	+	27B4➴Black	Feathered	South	East	ArrowArrows	Option	+	27B5➵Black	Feathered	Right	ArrowArrows	Option	+	27B6➶Black
Feathered	North	East	ArrowArrows	Option	+	27B7➷Bold	Black	Feathered	South	East	ArrowArrows	Option	+	27B8➸Bold	Black	Feathered	Right	ArrowArrows	Option	+	27B9➹Bold	Black	Feathered	North	East	ArrowArrows	Option	+	27BA➺Teardrop	Barbed	Right	ArrowArrows	Option	+	27BB➻Bold	Teardrop	Shanked	Right	ArrowArrows	Option	+
27BC➼Wedge	Tailed	Right	ArrowArrows	Option	+	27BD➽Heavy	Wedge	Tailed	Rightwards	ArrowArrows	Option	+	27BE➾Open	Outlined	Rightwards	ArrowArrows	Option	+	27BFDouble	Curly	LoopSymbol	Option	+	20A3₣French	FrancCurrency	Option	+	20A4₤British	PoundCurrency	Option	+	20A5₥Mill	SignCurrency	Option	+	20A6₦Nigerian
NairaCurrency	Option	+	20A7₧Spanish	PesetaCurrency	Option	+	20A8₨Indian	RupeeCurrency	Option	+	20A9₩South	Korean	WonCurrency	Option	+	20AA₪Israeli	New	SheqelCurrency	Option	+	20AB₫Vietnamese	DongCurrency	Option	+	20AC€Euro	SignCurrency	Option	+	20AD₭Laos	KipCurrency	Option	+	20AE₮Mongolian	TugrikCurrency
Option	+	20AF₯Greece	DrachmaCurrency	Option	+	20B0₰German	Penny	SignCurrency	Option	+	20B1₱Philippine	PesoCurrency	Option	+	20B2₲Paraguayan	GuaraniCurrency	Option	+	20B3₳Argentine	AustralCurrency	Option	+	20B4₴Ukrainian	HryvniaCurrency	Option	+	20B5₵Cent	SignCurrency	Option	+	20B9₹Indian	Rupee	SymbolCurrency
Option	+	20BA₺Turkish	LiraCurrency	Option	+	20BD₽Russian	RubleCurrency	Option	+	2211∑Summation	SignMath	Option	+	2213∓Minus	or	Plus	SignMath	Option	+	221A√Square	RootMath	Option	+	221B∛Cube	RootMath	Option	+	221C∜Fourth	RootMath	Option	+	221D∝Proportional	toMath	Option	+	221E∞InfinityMath	Option	+	221F∟Right
AngleMath	Option	+	2221∡Measured	AngleMath	Option	+	2225∥Parallel	toMath	Option	+	222B∫IntegralMath	Option	+	222C∬Double	IntegralMath	Option	+	222E∮Contour	IntegralMath	Option	+	222F∯Surface	IntegralMath	Option	+	2234∴ThereforeMath	Option	+	2235∵BecauseMath	Option	+	2237∷ProportionMath	Option	+	223A∺Geometric
ProportionMath	Option	+	2243≃Asymptotically	Equal	toMath	Option	+	2600☀Black	Sun	with	RaysWeather	Option	+	2601☁CloudWeather	Option	+	2602☂UmbrellaWeather	Option	+	2603☃SnowmanWeather	Option	+	2604☄CometWeather	Option	+	2605★Black	StarWeather	Option	+	2606☆White	StarWeather	Option	+	2607☇LightningWeather
Option	+	2608☈ThunderstormWeather	Option	+	2609☉Sun	SymbolWeather	Option	+	260E☎Black	TelephoneSymbol	Option	+	260F☏White	TelephoneSymbol	Option	+	2611☑Ballot	Box	with	CheckCheck	Option	+	2612☒Ballot	Box	with	CrossCross	Option	+	2613☓Cross	MarkCross	Option	+	261A☚Black	Hand	with	Left	Pointing	IndexSymbol	Option
+	261B☛Black	Hand	with	Right	Pointing	IndexSymbol	Option	+	261C☜White	Hand	with	Left	Pointing	IndexSymbol	Option	+	261D☝White	Hand	with	Up	Pointing	IndexSymbol	Option	+	261E☞White	Hand	with	Right	Pointing	IndexSymbol	Option	+	261F☟White	Hand	with	Down	Pointing	IndexSymbol	Option	+	2620☠Skull	and	CrossbonesSymbol
Option	+	263A☺White	Smiling	FaceSymbol	Option	+	263B☻Black	Smiling	FaceSymbol	Option	+	263C☼White	Sun	with	RaysWeather	Option	+	263D☽First	Quarter	MoonWeather	Option	+	263E☾Last	Quarter	MoonWeather	Option	+	2640♀Female	SymbolSymbol	Option	+	2642♂Male	SymbolSymbol	Option	+	2648♈AriesZodiac	Option	+
2649♉TaurusZodiac	Option	+	264A♊GeminiZodiac	Option	+	264B♋CancerZodiac	Option	+	264C♌LeoZodiac	Option	+	264D♍VirgoZodiac	Option	+	264E♎LibraZodiac	Option	+	264F♏ScorpioZodiac	Option	+	2650♐SagittariusZodiac	Option	+	2651♑CapricornZodiac	Option	+	2652♒AquariusZodiac	Option	+	2653♓PiscesZodiac	Option	+
2654♔White	Chess	KingSports	Option	+	2655♕White	Chess	QueenSports	Option	+	2656♖White	Chess	RookSports	Option	+	2657♗White	Chess	BishopSports	Option	+	2658♘White	Chess	KnightSports	Option	+	2659♙White	Chess	PawnSports	Option	+	265A♚Black	Chess	KingSports	Option	+	265B♛Black	Chess	QueenSports	Option	+	265C♜Black
Chess	RookSports	Option	+	265D♝Black	Chess	BishopSports	Option	+	265E♞Black	Chess	KnightSports	Option	+	265F♟Black	Chess	PawnSports	Option	+	2660♠Black	Spade	SuitSports	Option	+	2661♡White	Hearts	SuitSports	Option	+	2662♢White	Spade	SuitSports	Option	+	2663♣Black	Club	SuitSports	Option	+	2664♤White	Spade	SuitSports
Option	+	2665♥Black	Hearts	SuitSports	Option	+	2666♦Black	Diamond	SuitSports	Option	+	2667♧White	Club	SuitSports	Option	+	2669♩Crotchet	or	Quarter	noteMusic	Option	+	266A♪Quaver	or	Eighth	noteMusic	Option	+	266B♫Musical	Single	BarMusic	Option	+	266C♬Musical	Double	BarMusic	Option	+	266D♭Music	Flat	SignMusic	Option	+
266E♮Music	Natural	SignMusic	Option	+	266F♯Music	Sharp	SignMusic	You	can	use	one	of	the	option	keys	on	your	keyboard	to	use	the	shortcuts.	For	example,	press	“Option	+	Shift	+	=”	keys	together	to	make	plus	or	minus	symbol	like	±.	Using	Option	or	Alt	Keys	in	Mac	Keyboard	Similar	to	any	other	text	content,	you	can	increase	or	decrease	the
font	size	of	the	symbols	and	apply	colors	in	Mac.	Related:	1000+	alt	code	shortcuts	for	emoji	symbols	in	Windows.	You	can	use	the	below	shortcuts	as	a	reference	to	insert	accented	characters	in	Mac.	Remember,	while	option	+	a	will	produce	å,	you	don’t	need	to	press	and	hold	the	option	key	in	most	cases.	For	example,	pressing	option	+	u	will
produce	umlaut	with	the	two	dots	above	like	¨.	Now	you	can	leave	the	keys	and	type	e	to	produce	ë.	AccentExampleSmall	LetterCapital	Letter	Acuteá	Á[Option	+	E]	Vowel[Option	+	E]	[Shift	+	Vowel]	Circumflexâ	Â[Option	+	I]	Vowel[Option	+	I]	[Shift	+	Vowel]	Graveà	À[Option	+	`]	Vowel[Option	+	`]	[Shift	+	Vowel]	Umlautë	Ë[Option	+	U]
Vowel[Option	+	U]	[Shift	+	Vowel]	Cedillaç	ÇOption	+	COption	+	Shift	+	C	EszettßOption	+	SOption	+	S	Alternatively,	press	and	hold	a	special	letter	key	to	view	additional	options	similar	to	iPhone	or	iPad	keyboard.	In	order	to	show	the	options	in	capital	letters,	press	and	hold	shift	with	the	special	key.	Type	Accented	Small	Letters	in	Mac	Check	out
our	article	to	get	the	completed	list	of	500+	keyboard	shortcuts	to	type	accented	characters	in	Mac.	Mac	offers	different	keyboard	input	methods	to	type	in	a	language	different	than	your	standard	keyboard	layout.	You	can	change	the	input	method	to	Unicode	Hex	Input	and	type	keyboard	characters	and	accented	letters.	For	example,	after	switching
to	Unicode	Hex	Input,	open	Pages	and	type	Option	+	0024	to	insert	$	symbol.	You	need	to	use	this	method	for	most	of	the	shortcuts	in	the	above	table.	Similar	to	Windows	Character	Map,	Mac	has	a	Character	Viewer	tool	to	insert	emojis,	symbols	and	special	characters	in	any	text	content.	Press,	“Command	+	Control	+	Space”	or	“Fn	+	E”	keys	to
open	Character	Viewer	and	insert	the	symbol	you	need.	Mac	Character	Viewer	Alternatively,	you	can	also	select	“Show	Emoji	&	Symbols”	option	from	the	“Input	menu”	icon	in	the	top	menu	bar.	Show	Emoji	and	Symbols	in	Mac	In	Character	Viewer,	you	can	search	for	letters	under	“Latin”	group	or	search	breve	or	macron	to	find	all	relevant	letters.
Many	users	think	alt	code	shortcuts	are	useful	only	in	Windows	operating	system.	However,	you	can	also	use	option	or	alt	key	in	your	Mac	to	insert	symbols	and	special	characters.	In	addition,	you	can	also	use	Character	Viewer	to	insert	emojis	and	symbols	in	all	Mac	documents.	Tags:	Alt	CodeAppleEmojiKeyboardmacOSOption	CodeUnicode	I	used
Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service
recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll
down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before
entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	Page	content	loaded	Dec	31,	2012	9:17	AM	in	response	to	DANieuwland	You	probably	know	that	you	can	find	the	greek	symbols	in	Edit	>	Special	characters.	To	make	them	easier	to	use	you	can	in	the	Pages	Preferences	>	Auto	Corrections	add	a	key
combination	for	each	of	the	characters/symbols	you	need.	Here	you	see	I	have	one	for	an	arrow	symbol.	The	image	is	from	Pages	08	but	it	is	the	same	for	Pages	09.	Jan	1,	2013	6:20	AM	in	response	to	DANieuwland	Some	you	can	type:∑	π	ß	∂	∆	Ω	µare	all	available	if	you	hold	down	the	option	key	with	other	characters.Peter	Dec	31,	2012	9:21	AM	in
response	to	DANieuwland	In	System	Preferences	>	Language	&	Text	>	Input	Sources:Check	Keyboard	&	Character	ViewerCheck	Show	Input	menu	in	menu	barExit	System	Preferences.On	Finder	menu	bar	next	to	date,	select	Show	Character	Viewer.	In	the	window	that	pops	up,	you	will	see	a	default	list	of	character	collections	on	the	left	panel	--	but
no	Greek	Symbols.	Select	the	small	gear	icon	and	Customize	List...	Scroll	down	until	you	see	European	Alphabetic	Scripts	section.	If	it	is	not	already	expanded,	click	to	do	so.	Select	Greek.	It	will	now	appear	at	the	bottom	of	the	character	panel.	Select	this	Greek	symbol	category.Launch	Pages	and	the	document	where	you	want	to	include	Greek
symbols.	Place	the	cursor	where	you	want	specific	symbols	located.	Now,	in	the	Character	viewer,	double-click	the	Greek	symbol	to	place	it	in	your	Pages	document	...	like	this:	ΘΞΔ.I	should	mention	that	you	can	launch	the	Character	viewer	from	within	Pages	>	Edit	>	Special	Characters...	Jan	1,	2013	7:50	AM	in	response	to	PeterBreis0807
PeterBreis0807	wrote:	Some	you	can	type:	∑	π	ß	∂	∆	Ω	µß	is	not	Greek	but	German.	Jan	1,	2013	8:29	AM	in	response	to	Tom	Gewecke	I	know	Tom.	But	it	makes	a	nice	fudge	for	Beta,	just	as	√	the	square	root	makes	a	good	tick	if	you	are	typing.Peter	Jan	1,	2013	9:33	AM	in	response	to	PeterBreis0807	PeterBreis0807	wrote:	it	makes	a	nice	fudge	for
BetaThat	is	really	awful	advice,	βut	to	start	off	the	new	year	I	will	grant	you	a	fudge:-)	Jan	1,	2013	9:43	AM	in	response	to	Tom	Gewecke	Too	much	time	at	the	βeach	...	over	Christmas.¨	Oct	19,	2013	4:14	AM	in	response	to	VikingOSX	Very	helpful,	solved	my	problem!	I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to
give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run
Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white
space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a
second.	I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for	such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"
template,	set	"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,	"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard
Shortcuts	>>	Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The	only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,
mouse	click,	etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	I	used	Automator	to	make	a	Service	workflow,	and	Keyboard	System	Preferences	to	give	it	a	combo	keystroke.	Text-replacement	wasn't	introduced	until	10.13	High	Sierra,	and	this	was	the	best	single-keystroke	method	I	found	for
such	versions	(tested	on	10.6	Snow	Leopard).	First	open	Applications	>>	Automator,	choose	the	"Service"	template,	set	"Service	recieves"	to	"no	input",	enable	"Replaces	selected	text",	doubleclick	the	"Run	Applescript"	action,	replace	its	contents	with	the	following:	on	run	{}	return	(character	id	945)	end	run	and	Save	it	with	your	desired	name	(e.g.,
"α",	"Paste	an	alpha	character",	etc.).	Then	open	System	Preferences	>>	Keyboard	>>	Keyboard	Shortcuts	>>	Services,	scroll	down	to	Text	services,	find	your	new	one,	click	somewhere	in	the	empty	white	space	to	the	farthest	right	of	its	name,	and	when	the	text	entry	box	appears,	press	your	desired	key	combo	(I	used	command-option-shift-A).	The
only	downsides	are	that	it	leaves	the	character	selected,	so	you	have	to	deselect	it	(right-cursor,	mouse	click,	etc.)	before	entering	more	text	(which	I	guess	makes	it	2	keystrokes),	and	it's	slow,	takes	about	a	second.	Page	content	loaded	Apr	4,	2018	8:26	AM	in	response	to	cjonesfly	Press	Control	+	Command	+	SpaceA	dialog	box	will	open	(Character
viewer)Search	"delta"	by	typing	it	in	the	text	field	on	the	top-left	cornerClick	on	the	Δ	symbol	to	insert	it	Apr	2,	2018	10:13	AM	in	response	to	cjonesfly	Press	the	Option	and	J	keys,	or	copy	and	paste	∆,	or	choose	Utilities	from	the	Finder’s	Go	menu,	open	the	Script	Editor,	and	run	'character	id	8710’	without	the	quotes.(159268)	Apr	2,	2018	12:27	PM
in	response	to	cjonesfly	In	Pages	v6.1	or	later,	you	can	press	option+command+E	to	open	the	built-in	Equation	editor,	and	you	enter	the	Greek	Delta	(Δ)	character	as	the	LaTeX	construct:\DeltaThere	has	been	no	built-in	equation	editor	in	Pages	'09	through	v6.0.	One	uses	Design	Science's	MathType	that	can	integrate	with	the	Pages	Insert	menu.	One
can	still	use	MathType,	instead	of	the	built-in	equation	editor	in	Pages	v6.1	(or	later)	with	a	slight	change	in	the	Pages	Preferences	:	General	panel.	Apr	2,	2018	10:46	AM	in	response	to	cjonesfly	cjonesfly	wrote:	I	want	to	insert	a	symbol	In	general	the	way	to	do	this	is	via	the	Character	ViewerHow	to	type	accents,	emoji,	and	symbols	on	your	Mac	-
Apple	Support	Apr	2,	2018	10:43	AM	in	response	to	cjonesfly	Equation	Editor	was	replaced	by	Grapher.In	Grapher:Menu	>	Window	>	Show	Equation	PaletteBut	as	Niel	as	said	you	can	type	∆.Peter	You	don’t	have	to	be	the	fastest,	strongest,	or	most	assertive	to	insert	the	alpha	symbol	(α)	into	a	document	on	a	Windows	PC,	on	a	Mac,	or	on	an	iOS	or
Android	device.	With	quick	and	easy	keyboard	shortcuts,	anyone	can	type	this	ancient	Greek	letter	and	math	symbol.We	explain	each	method	below.	How	to	Insert	the	Alpha	Symbol	on	a	Windows	PCOn	a	Windows	PC,	click	to	the	place	in	your	document	where	you	would	like	to	insert	the	alpha	symbol.	Next,	hold	the	Alt	key	and	type	the	numbers
224.If	you’re	using	Microsoft	Word,	you	can	also	access	the	alpha	symbol	in	the	Advanced	Symbols	library	under	the	Insert	tab.	Once	you	access	the	library,	type	“alpha”	in	the	search	bar.	Now	double	click	on	the	α	to	include	the	symbol	in	your	document.Alpha	SymbolIf	you	plan	to	use	the	alpha	symbol	multiple	times	in	a	Microsoft	Word	document,
you	can	adjust	your	AutoCorrect	options	to	automatically	replace	a	word	or	phrase	(such	as	“alpha”)	with	the	symbol.	First,	copy	the	symbol	from	this	article:	α.	Then,	search	under	the	Tools	tab	for	AutoCorrect	options.	In	the	replace	field,	choose	a	word	or	phrase	(such	as	“alpha”)	and	then	in	the	with	field,	paste	the	symbol.	Now	press	add.	How	to
Insert	the	Alpha	Symbol	on	a	MacFind	the	alpha	symbol	by	going	to	your	Mac’s	Emoji	and	Symbols	library.	Simultaneously	press	Control,	Command,	and	Spacebar	to	open	the	Character	Viewer.	Search	for	“alpha.”	Then	double-click	the	alpha	symbol	or	highlight	and	drag	the	symbol	into	your	document.	Related:Navigating	the	Cloud:	How	to	Choose
the	Right	Provider	for	Your	BusinessHow	to	Insert	the	Alpha	Symbol	on	an	iPhone	or	iPadThere	are	mathematically	constant	ways	to	type	the	alpha	symbol	from	the	keyboard	of	an	IOS	or	Android	device.On	an	iPhone,	change	your	keyboard	settings	to	include	Greek.	Under	Settings,	tap	General,	then	Keyboards.	From	here,	you	can	“Add	New
Keyboard.”	Now	you	can	open	the	application	where	you	would	like	to	type	the	alpha	sign,	which	is	the	Greek	lowercase	a.	How	to	Insert	the	Alpha	Symbol	on	an	Android	PhoneIf	you’ve	installed	Gboard	on	your	Android	Phone,	you	can	find	the	alpha	symbol	by	adding	Greek	to	your	keyboard.	First	tap	on	Settings,	then	Languages,	followed	by	Add
keyboard.	Then	find	the	Greek	lowercase	a	to	insert	the	alpha	symbol	into	your	document	or	message.	Additional	ResourcesRelated:Cloud	Cost	Optimization:	How	to	Get	the	Biggest	Bang	for	Your	Buck


